Plunge Guide - Utilize Your Personal
Pages

This guide is designed to help registered Plungers at any level of expertise use

their personal pages.

Good luck!

Logging In and Accessing Your Pages —

Visit the Plunge website and select Log In from the menu on the left. This will take you
to your personal page. From here, you can access the capabilities your personal plunge

pages have to offer.

You can access all of the tools and features of your personal page with the top
navigation tabs.

Top
navigational
tabs

Welcome, Emily Testerman!
Your Participant ID: 344790254

New to your Headquarters?
Start here!

Your Personal Page link:
http://plunge2012.kintera.org/emilyann

My Fundraising Goal:
$50.00

Change My Goal

Money Raised to Date:
$0.00

View My Reports

® |astFive Days v

Total for Range: $0

INo Donations Available

100%

50%
25%

My To Do List

Build/Edit my Webpage

Send Emails to Friends and Family
Enter Offline Donations

Edit my Profile

Edit my Login/Password

Check the Message Board

See Important Dates

® Emails Sent: 1
Send More Emails
® Visits to My Pages: 0

® Number of Donations: 0
® Number of Registrations: 0

i

Go Team Adcieo!

® Team Members: 4
® Team Fundraising Goal: $1,000.00
® Team Raised to Date: $0.00

Are you a team captain?
Send an email to your team




MY HQ acts as the home tab. Here you can track your fundraising progress, view the link
to your personal page, send emails and edit your personal page.

@ Fundraising Statistics
})

- My Fundraising Goal: 100%
$50.00
Change My Goal 50%
o Money Raised to Date: 250
$0.00

View My Reports

® |astFive Days v

Total for Range: $0

No Donations Available

Fundraising statistics - Here you have the
option to increase your fundraising goal and run reports on donations.

On the email statistics table, you can quickly view email analytics, including how many
have been sent, and how many clicks/donations you have received from the emails.

@ Email Statistics
® Emails Sent: 1
Send More Emails
® Visits to My Pages: 0
® Number of Donations: 0
® Number of Registrations: 0



/

Select
from a list
of cool
themes
we have
for youl!

My Webpage

On the My Webpage tab you can customize your personal page. Give it your own style
and make it grab the attention of your family and friends.

Edit your Personal Page

Header Text:

Line 1:
Welcome to the Donation Page of

Line 2:
Emily Testerman

Do you want a Video or Image? Image v

Webpage image

You may use the default image or plungcmd‘com

select an image from the library or “ Gz‘h /H‘ h' NU "A\ L ‘ "lS D)

upload your own. .

Choose a theme
Customize your page with fun
backgrounds.

Standard ¥

Preview webpage
View your page as others will see it!

Here you can edit what you
want others to see when
they enter your page. Add
your own welcome message!

Preview

Finish webpage
To complete your webpage or to save
changes, click Submit.

| submit || cancel |

Caption under image:

Join me in my efforts to support ngalo&l

Edit the text:

Here you select what image you want
to appear when others are directed to
your page. You may select a provided

image, or upload your own.

Be a fan of fun - please
support me as I take part in
the coolest event around and
help Special Olympics -
Maryland.

Here you can edit what
the text blurb says
below your image.




Import or select an image below

Import your image here:
(You may upload up to 2 images.)

Standard Image Library

Browse_

Images must be .jpg or .gif files.
Recommendation:

300x234 pixels

Maximum size:

50KB

If you upload two images, they will
appear side-by-side on your personal
page.

Click here to return

If you decide to select your own

picture, click browse to locate the file
on your computer. Then, click submit!

Plungers running In!

_ Plunge bear

Once you’re finished personalizing, preview what your page will look like by clicking

“View Personal Page” at the top, or clicking the “Preview” button on the edit page.




Welcome to the Donation Page of
Emily Testerman

My Team Page

Thank you for your
involvement!

plungemd.com
~L 1A Y

Enter Donation Amount Here:
*Currency shovn: US Dollar

$

_ I vant to enter the donation in my
ovn name; pre-fill the entry form for

me.
My 100%
Fundraising
Goal:
$50.00 ol
Money 25%
Raised to
Date:
$0.00

If you are unable to
donate online, please
print out a donation
form.

Join me in my efforts to support Special
Olympics - Maryland!

Be a fan of fun - please support me as I take
part in the coolest event around and help
Special Olympics - Maryland.

Finish webpage
To complete your webpage or to
save changes, click Submit.

TN | S

Voila! If you like the page, be sure to click submit. Don’t worry, you can always go back

in and edit at any time.




Email

Email: you can start email campaigns to get friends and family to help add to your
donations and build your teams!

Emily Testerman's Email Center

Compose your email here and send it off to your current/potential donors. Create your own email
message or select a template.

Compose Email Message

From: Emily Testerman Sender Email: emily.testerman@adcieo.com

* Required Information

@Exglain ADDRESS BOOK

Greeting™ Recipient Email*

The Greetings

Tab is your place

to say “Dear

You can send this email to up to 30 pegble! Total recipients: 5 ¥

Mom,” or simply,

“Hey Dude!” as Here's your place to add your

the start of your To make it so you don’t have to re- email recipient’s email

email. type email address every time, add address(es). Add up to 30! You can
email address individually or by change the amount of rows
group. That way, next time, you can available by clicking the dropdown
simply check off their box and add box and selecting the correct
them to vour recipient list. amount.




After sel

ecting your recipients, you can create the body of the email.

Since you'll be sending more than one email,
this option allows you to name each email
specifically, so you can come back and use it,
or make changes to it later. You can save up
to six private templates.

/

Templ

ate: Donor Solicitation Email Template (¢) ¥ save As ...

(c)common template (p)private template

*Subject: Rare Breed of Regional Polar Bears In Needing of Funding The subject is what your
e s \ recipient will see in their
Highlighte : .
. ?
Message: What's this? email browser as the
(Your personal donation page link will be appended to the bottom of your email) subject line.
*Body: on January 28, 2012, the 16th annual MSP Polar Bear The highlighted message
Plunge will bring together thousands of chill-seekers will be bolded
from all over to "bear™ the wintry waters of the
Chesapeake Bay. The adrenaline junkies and warm-— information displayed at
hearted souls al}ke need not only the courage, but thetopofyouremaH—
1so the funds, in order to be a part of this ) ] ]
exhilarating experience. This special breed of make it motivational!
Maryland polar bears needs your help! =

Here is where you type

your message. We have
a default in for you, but
feel free to make it your
own!

Since 1997, nearly 70,000 people have braved the

bitter waters of the bay in support of Special

Olympics Maryland, raising a collective $19 million.
Last year, the Plunge raised over $3 million in funds

in support of Maryland’s children and adults with
intellectual disabilities. The only way to top that X

Preview Email Send Email

When you are finished typing your body, click “Preview Email” to open a window which

will display the message your recipients will see. If you like it, click “Send Email.” And off

they go!



If you’d like to import your own email address book from a web browser, it’s easy! From

the top menu select “Address Book Import.”

My HQ My Webpage Email Reports Tools Community
Send Email | Address Book Import | Email History Log | Facebook | Twitter
Address Book Import

Where do you keep your contacts?

Gmail

” . .
&7 Windows Live

YzHoO!

Gadgets

Logout

If you’re using Outlook on your
computer for email, you may want to
export your contacts to a CSV file. Open
Outlook, find your contact list, and
select the Save As... or
Export...menu option, usually from
the File menu Follow the direction

ué’] E Comma Separated Value (.csv) €—

o save the file in a Comma
Separated Value (CSV) format.
Then, click here to export your Outlook
contacts from the CSV.

All you have to do is enter which address book you’d like to import, enter your password
information to sign in. Once successfully logged in, click “OK” to allow your page to
access the addresses. You then see the below screen, allowing you to select and add any
emails from this list you’d like. Easy! Those contacts are now in your address book.




Step2: Select Contacts Import Wizard Help|

| Contacts found!

e comtacts______|
2

zaid-v-@hotmail.com

B borrowerservices
borrowerservices@glhec.org

EI vitamindg@hotmail.com

D Doug Hucker
doug_hucker@hotmail.com

-

holmgren353@hotmail.com

O amandakarfakis@hotmail.com

If you’d like to see the history of emails sent, click “Email History Log” on the navigation.
Email History Log

Use this email log to check who you have sent email to and how they have responded. To re-send
emails to individuals, check the box next to their names and click the link at the bottom.

Click Update Log to view the most recent email log information.

Addressee a Email Address Date Sent

Hello iamsupahfly@gmail.com 11/08/2011 0

Send email to this person

You'll see a list of the statistics for each email you’ve sent.

Emily Testerman’s Email Center

From the Email tab, you can also connect your personal page to Facebook and Twitter.

Update your Facebook Status

Communicating with your friends and family in Facebook to reach your fundraising
goal is easy!

® Click the 'Connect with Facebook' button and login
® Allow permission for the event to update your Facebook status
® Fill out the textbox and click the 'Update your Status' button

[ Connectwith Facebook

Once you enter your log-ins for Facebook or Twitter, you can share your personal page
with your friends and drive traffic to your page!



Reports

Reports: you can check in and see how close you are to reaching your fundraising goal.

My HQ My Webpage  Email  Reports  Tools  Community  Gadgets

Donation Report : Logouf

Emily Testerman's Donation Statistics

This is where you can check your donation status. View your total and watch as contributions come in and
you get closer and closer to your goal! To send out email messages to your Donors, check the individual
boxes for each recipient and complete the '‘Compose Email Message' section.

Fundraising Goal $50.00
Amount needed towards goal $50.00

Progress Towards Your Goal

Confirmed Amount Raised

$0.00

Online Amount - online processing(ie. credit cards) $0.00
Offline Amount - (checks, cash, charge and inkind) $0.00
Current Balance $0.00

Your registration fee, if applicable, has been included in the current balance figure.
Check with the organization to determine if the registration fee is counted towards the receipt of fundraising prizes.

Team Name: Adcieo

Showing 1-1 of 1 record (1 page), 20 w records per page.

%) Export XLS
Prev 1 Next Choose Columns

&printable

rf [‘ 131111983 Emily Testerman Adciec £0.00 £0.00 Paid 11/08/2011

If you'd like,
you can access
a printable
version, or
export your list
of donations to
an excel
spreadsheet to
have your
report offline.




Tools

The Tools tab features handy capabilities allowing you easy access to forms and edit
functions.

Your pledge entry history is displayed. "Pending” donations refer to donations that have not
been cleared by the organization. As soon as they are confirmed, those donations are marked
as received and can be viewed in your donation report.

To enter new donations, click the "Enter Pledge" button. To view the details of donations that
are still pending, click the "View Pending” next to the date the donations were entered.

_ Enter Pledge

Pledge Entry History
Event ID#: 484131 Event Name: The 16th Annual MSP Polar Bear Plunge
Name: Emily Testerman Participant ID#: 344790254

This page you are greeted with allows you to manually enter a pledge you have received
in paper/person form, and a list of all of those you have manually entered so far.

Donation Entry

Title:* - please make a selection—- v
First Name:™

Last Name:™

Email:

Address Line 1:*

Address Line 2:

City:*

State:™ Maryland v
ZIP/Postal Code:™

Phone:

Birth Date: (MM/DD/YYYY)

Payment Type:* CHECK +
Check Number:=

Donation Amount:* $

Will this donation be potentially matched?

If you know the following information regarding the matching gift,
please complete.

Company Name:

Matching Gift Amount: $




From the “Print Donation Form” option, you can print out donation forms to hand to
your family and friends if they prefer to donate that way. Once clicked, your computer
will ask you to open or save the file. Using Adobe Acrobat, open the file. Click OK. From

there you can print out as many copies as you like.

Opening 484131-344790254.PDF

You have chosen to open

“Y 484131-344790254.PDF

which is a: Adobe Acrobat Document
from: http://pdfkintera.com

What should Firefox do with this file?

@ Open with | Adobe Reader (default)

() Save File

"] Do this automatically for files like this from now on.




The next option on the Tools tab is “Edit Profile.” By clicking here, you can edit the form you
initially filled out when registering for the Plunge. This comes in handy if you change your
mind about a shirt, move, or want to change your fundraising goal or plunge time!

Edit Profile

You can update your profile information here. Just fill out the fields
below.

Title: ™ Ms. v

First Name:* Emily

Middle Initial: A

Last Name:™ Testerman

Company Name: Adcieo

Email: = emily.testerman@adci

Address Line 1:* 3500 Boston Street

Address Line 2: Suite 315

City:™ Baltimore

State:* Vlvrlarylandr v

ZIP/Postal Code:™ 21224

Phone:

Birth Date: ™ 521/19788 (MM/DD

/YYYY)

Gender:* @ remale © male

School:

LU e

ggr’zd&%gopl:u};egzr;g out the SOMD Website v Fundraising Goal:* $ 50
@ You are a member of the Team: (None)
\:_,I TR To join another Team, click here.

_Is_srllee(;tzjour 2012 Plunge ‘?‘ AEM I want to start my own team and become a Team Captain
'/ Pee Wee Plunge (11 AM)

Would you like more \6: :m“y Elonoe (122N Notify me by email when somebody donates to me.

o o O

Just click update and you’re done.



Additionally, from the Tools tab, you can choose “Edit Login.” If you want to change

your password or username to something more easily remembered, this is the place to
do it. Click Update when you’re finished.

Edit Login
To modify your login, please make changes to the fields below.
Modify Login:
*Username emilyann821
“Password
*Verify Password

*Security Question Whatis your mother's maiden name v

“Security Answer  trammell




Community

Within the Community tab, you can see what other Plungers are up to. One of the
features is a bulletin board, where you can see what other people are talking or asking
about. This is a great feature to see if someone answers a question, or to post an idea
you might have. Just click “Post Message.”

Bulletin Board
Previous Page 1234
# of Renr-es Imm
Donation Flyer nitebatman 11/15/2011
HI!! 1 tirzajo 11/09/2011
honor roll 0 Jeff Manley 11/01/2011
honor roll 0 Jeff Manley 11/01/2011
Gadgets 0 Jeff Manley 11/01/2011
By At Reply | @ print

The “Important Dates” function will fill once the date nears, so check back often!



Gadgets

Finally, the Gadgets tab is for those of you with websites in which you’d like to promote
your personal page and drive donations!

My HQ My Webpage Email Reports Tools Community Gadgets
Logout

Add these Gadgets to your Community Page

Honor Roll:

Copy the code below to your community page to display your honor
roll.

Plunger Honor Roll +
Embed: <embed src="http://plunge2012.k

In Honor of John
Smith

In Honor of John

Ewent Name
- Donations

Thermometer:

Copy the code below to your community page to display your
thermometer.

I've Raised
$109

My Goal Plunger Thermometer b
$109 Embed: <embed src="htip://plunge2012.k

To place either of these cool gadgets on your website, simply copy the Embed code, and
then paste it where you would like it to appear on your website. Also, the gadgets are
clickable, and will direct people to your personal page.

Happy Plunging!




